LABORATORY MANUAL

Introduction
To
Computer Science
And
Programming

Office 2010
# Introduction to Computer Science

Course outline area wise.

<table>
<thead>
<tr>
<th>S No.</th>
<th>PART</th>
<th>TOPIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>COMPUTER HARDWARE</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>SOFTWARE INSTALLATION</td>
</tr>
<tr>
<td>3</td>
<td>C</td>
<td>NETWORKING</td>
</tr>
<tr>
<td>4</td>
<td>D</td>
<td>MICROSOFT OFFICE</td>
</tr>
<tr>
<td>5</td>
<td>E</td>
<td>COMPUTER PROGRAMMING</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Introduction to Computer Science

## Index

<table>
<thead>
<tr>
<th>S No.</th>
<th>Object of Experiments</th>
<th>Remarks</th>
<th>Date</th>
<th>Signature</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>E</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Object of Experiments

1. **A**

2. **B**
   - Formatting hard disk, Installation of, Antivirus, Utility programs, device drivers.

3. **C**
   - Connecting to network and sharing files over network. User Login, Iqra University Fileserver, shared folders, Elibrary, Lectures, Software, email, SIC login.

4. **D**
   - MS Word: Index, Table of contents (Report), Mail Merge (Bank Statement).

5. **E**
   - MS Excel: Formulas, SUM, Percentage, IF, Nested IF, AND, OR (Marks Sheet).

6. **F**
   - MS Access: Tables, Primary Key, Forms, Form connectivity (IU Database).

7. **G**
   - C compiler Setup, C compiler environment, setting path, saving, opening, compilation.

8. **H**
   - Error detection/correction, clrscr, getch.

9. **I**
   - Data types.

10. **J**
    - Variables, variable names and related errors.

11. **K**
    - Declaration, initialization.

12. **L**
    - Taking input from User.

13. **M**
    - Implementing simple math equations and formulas.

14. **N**
    - Formulas for inter conversion

15. **O**
    - Lab course semester project

16. **P**
    -
Experiment 1

Assembling the components into a working computer

The following pictures have some slight differences from the instructions. The instructions are for the standard workstation. The pictures are for a computer that Tanja Lange and I assembled on 2006.01.11, with the following differences from the standard workstation:

- There are two disk drives instead of one.
- The video card is an Asus V9400-X/TD/128 instead of an Asus V9400-X/TD/64.
- The DVD drive is a LiteOn SHM-165P8S-09C, which we found easier to obtain than the BenQ DQ60BLACK.
- There's no extra fan. (All the other components showed up before the extra fan did.)
- Assembly was in a slightly different order.

Opening the case. Unpack the computer case. Discard its plastic wrap. Put on an antistatic wrist strap, and attach it to ground (for example, to the screw on a typical light-switch plate).

http://cr.yp.to/hardware/build-20060107.html

Remove the side of the case by pulling the two side latches towards the front of the case and then away from the case:
Look for power supply and the proper power cord latches:
Look for processor and Ram Slots. Ram is placed vertically in thin straight slots shown in above image on left. Whereas processor is a square shaped chip.
Heat sink is first placed over processor then a fan is placed above it:

Then place the mother board inside the casing with a plastic sheet coating at the back fixed using screw drivers:
Look for proper power cables to power up the motherboard which in turn will provide power to RAM and Processor (Power Cable used above is suitable for motherboard):
Plug the reset-switch, power-switch, HDD-LED (also known as IDE-LED) and PC Speaker connectors into the motherboard, all labels facing upwards:

Plug the front Panel USB Port cable into the motherboard:
Plug the video card into the motherboard:
Slide the DVD drive into the case from the front until the drive rails snap into place. Plug the UATA cable into the blue connector on the motherboard:
Plug a 4-pin power cable into the DVD drive
Experiment 2

Objective
Formatting hard disk, Installation of, Antivirus, Utility programs, device drivers.
Experiment 3

Objective
Connecting to network and sharing files over network. User Login, Iqra University Fileserver, shared folders, Elibrary, Lectures, Software, email, SIC login.

Window User Login
Most lab computers have Windows Xp operating system. Below is the login window of windows Xp. Press Ctrl+Alt+Delete

Enter your own login id and password as assigned by the ITSS Department or use the following information.

User name: room
Password: server

(Please note that except administrator user id all logins will be done on IQRA so the third drop list option of log on to will be IQRA incase of room user id and (This Computer) option will be selected in case of administrator user id)

(Please note that user id room has limited rights and is meant for one login for new admission until they get their personal windows login. Students should always use their own login id and password.)

Iqra University Fileserver
Iqra University has a fileserver connected through network switches. On this fileserver there are few common network drives with different access rights to different users. They can be accessed by opening my computer.

Following network drive icons are accessible by double clicking My Computer.

<table>
<thead>
<tr>
<th>Rights</th>
<th>Integrity</th>
<th>Accessibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum (copy, read, write, modify)</td>
<td>Personal to user only</td>
<td>From all computer within University Campus</td>
</tr>
</tbody>
</table>

This network drive shows a name similar to the login window. It is personal to the user and data placed in this network folder is visible to the user only. Data saved on this drive can be accessed by the user from any university computer at any time. User has full modification rights of this folder e.g. read, write, copy and delete.
This network drive has lectures folders of all faculty members showing with their names. This folder is accessible from any university computer. Students can only read and copy data from this folder and cannot modify.

<table>
<thead>
<tr>
<th>Rights</th>
<th>Integrity</th>
<th>Accessibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limited (copy, read only)</td>
<td>Modification personal to teacher. Visible to students.</td>
<td>From all computer within University Campus</td>
</tr>
</tbody>
</table>

This network drive has all possible up-to-date software's for Business, Media Science and Engineering. This folder is accessible from any university computer. Students can only read and copy data from this folder and cannot modify.

<table>
<thead>
<tr>
<th>Rights</th>
<th>Integrity</th>
<th>Accessibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limited (copy, read only)</td>
<td>Visible to students.</td>
<td>From all computer within University Campus</td>
</tr>
</tbody>
</table>

This network drive stores data of any user of universities network. This folder is accessible from any university computer. Teachers, Staff, Students etc have full rights of this folder and can copy/paste from or to this folder. Placing personal information or pictures on this folder may not be a good approach. Misuse of this folder will lead to strict action.

<table>
<thead>
<tr>
<th>Rights</th>
<th>Integrity</th>
<th>Accessibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum (copy, read, write, modify)</td>
<td>Personal to user only</td>
<td>From all computer within University Campus</td>
</tr>
</tbody>
</table>

(Please note that students should store any data in their personal storage visible in My Computer as a network drive with students name and not in the My Documents folder of any computer)
Experiment 4

Objective
MS Word: Index, Table of contents (Report), Mail Merge (Bank Statement).

In Word, you can create a TOC based on a portion of the text in a paragraph without including the whole paragraph. You can mark text by using the Lead-in Emphasis feature with heading styles to include the text in a TOC.

To insert a table of contents, follow these steps:
1. Start Word, and then open your document.
2. Click an empty paragraph where you want to insert the TOC.
3. On the menu, point to Reference, and then click Index and Tables.

Note In Microsoft Office Word 2007 or in Word 2010, click Table of Contents in the Table of Contents group on the References tab. Then, click Insert Table of Contents.
4. Click the Table of Contents tab, and then click Show Outlining Toolbar.

Note In Word 2007 or in Word 2010, skip this step.
5. In the Index and Tables dialog box, select the options that you want to apply to your TOC, and then click OK.

Note In Word 2007 or in Word 2010, select the options that you want to apply to the TOC in the Table of Contents dialog box, and then click OK.

Note If the text that is contained in your document is not marked to be included in a TOC, you receive the following error message in your document instead of the TOC:
Error! No table of contents entries found.

Mark the Text to Include in the Table of Contents
The next step is to mark the text that you want to include in your TOC by using Lead-in Emphasis with heading styles. Use one or more of the following methods to mark text that you want to include in the TOC.

Use Lead-in Emphasis with Heading Styles
1. Select any lead-in text in your document that you want to include in your TOC. For example, you may have a paragraph that includes lead-in text to introduce the remainder of the paragraph's text. In the following paragraph, if you want to include the introductory words "Widow and Orphan" in your TOC, just select these words, and then continue with the steps.

Widow and Orphan: A widow is the last line of a paragraph printed by itself at the top of a page. An orphan is the first line of a paragraph printed by itself at the bottom of a page.

2. Click the drop-down arrow in the Style box on the Formatting toolbar, and then select the heading that you want.

Note In Word 2007 or in Word 2010, click the heading style that you want in the Styles group on the Home tab.
3. Click Update TOC on the Outlining toolbar to update the TOC.

Note In Word 2007 or in Word 2010, click Update Table in the Table of Contents group on the References tab.
4. In the Update Table of Contents dialog box, click Update the Entire table, and then click OK.

Note In Word 2007 or in Word 2010, click Update the Entire table in the Update Table of Contents dialog box.

If you click Show/Hide on the standard toolbar, note that there are no special characters in the paragraph to indicate lead-in emphasis applied to the text. However, the text formatted as a heading level appears in the document's TOC. Because no hidden paragraph markers or other items are used, the whole process is seamless. Word uses a new underlying feature named "Linked character styles" to do this.

The heading style applied to the lead-in portion of the document is displayed as a heading style, but it is actually a linked character style. In Word 2002 and later, when you apply a paragraph style to a subset of paragraph, the following behavior occurs:

- A hidden character style is created that takes the same character properties as the paragraph style being applied.
- The character style is applied to the selection.

NOTE: The hidden character style created with linked character styles appears in the Style drop-down list if the document is opened and viewed in earlier versions of Word. The functionality of the style separator is lost if the document is saved in an earlier version of Word.

To view the hidden character style, follow these steps:
1. On the Format menu, click Reveal Formatting.

The Reveal Formatting task pane appears.

Note To open the Reveal Formatting task pane in Word 2007 or in Word 2010, follow these steps:
Use Style Separators with Heading Styles
The style separator is a new feature to Word 2003 and Word 2002. Style separator tags allow you to do the following:

- Apply heading styles to a single word or phrase in a paragraph so that only that word or phrase appears in the TOC.
- Include two styles in a single paragraph so that the lead-in paragraph appears in the TOC.
- Apply outline levels to lead-in text so that only the lead-in text appears in the TOC.
- Apply outline levels to a single word or phrase in a paragraph so that only that word or phrase appears in the TOC.

The style separator is a hidden paragraph mark that serves as a delineator between separate styles applied in a document. To make the style separator mark visible, follow these steps:

1. On the Tools menu, click Options.
2. On the View tab, click All under Formatting Marks.
3. Click Customize on the Tools menu.
4. Click the Commands tab, and then click All Commands in the Categories list.
5. Locate InsertStyleSeparator in the Commands list, and then drag it to the Formatting toolbar. Click Close.

To add the Style Separator button to the toolbar in Office Word 2007 or in Word 2010, follow these steps:

1. Click the Microsoft Office button, and then click Word Options.
2. Click Customize.
3. In the Choose commands from list, click All Commands.
4. In the list of commands, click Style Separator, click Add, and then click OK.

Insert the style separator before you apply the heading style to your text. To do this, use one of the following methods.

Method A: Use Style Separators to add a single word or phrase in a paragraph to the TOC:

1. As you type, and you reach a word or phrase in a paragraph that you want to include in the TOC, click the Style Separator button.
2. When you click the Style Separator button, the insertion point moves to the right of the separator so that you can continue typing.
3. Type the word or phrase that you want to include in the TOC, and then click the Style Separator button again.
4. Select the word or phrase that you want to include in the TOC, click the drop-down arrow in the Stylebox on the Formatting toolbar, and then select the heading that you want.

The word or phrase between the two style separators appears in the TOC.

Method B: Insert the Style Separator between two existing paragraphs:

You can use the style separator between two existing paragraphs so that the first paragraph becomes the lead-in text and appears in the TOC, and the second paragraph is the remainder of the text and does not appear in the TOC. To do this, follow these steps:

1. Create two paragraphs of text, placing text that you want to appear in the TOC in the first paragraph, the remainder of the text in the second paragraph.
2. Position the insertion point in the first paragraph, and then click the Style Separator button.

The two paragraphs appear to become a single paragraph by converting the paragraph mark at the end of the first paragraph to a style separator. You now have a single compound paragraph, which shows up as two separate paragraphs in Outline view, but which prints as a single paragraph.

3. Select the text to the left of the separator, click the drop-down arrow in the Stylebox on the Formatting toolbar, and then select the heading that you want.

The TOC displays only the lead-in portion (the first paragraph) formatted with the heading style.

NOTE: The style separator is a special form of a hidden paragraph mark. Therefore, documents with style separators that are created in Word 2002 and in later versions of Word appear the same in Word 2000 and in Microsoft Word 97 unless you click All under Formatting Marks. If you click All under Formatting Marks in earlier versions of Word, the style separator hidden paragraph mark appears as a normal paragraph mark, and the document will be repaginated.

When you use an earlier version of Word to view documents that have style separators that were created in Word 2002 and in later versions of Word, do not click All under Formatting Marks.

Removing a Heading from the Table of Contents
If you want to remove a heading from the TOC, you can apply a new paragraph style to the marked text:
1. Select the marked text, click the drop-down arrow in the Style box on the Formatting toolbar, and then select the heading that you want. (Click Normal to remove the heading style.)

Click Update TOC on the Outlining toolbar to update the TOC.
Experiment 5

Objective
MS Excel: Formulas, SUM, Percentage, IF, Nested IF, AND, OR (Marks Sheet).

Using an Excel worksheet - Using Equations

Step 1. Preparing to enter an equation
You are ready to build your own function (an equation). There is a single keystroke that informs Excel of your intention. Press the equal key (=). If you can write the equation, Excel can perform the calculation. This module will deal with four simple functions; add, subtract, multiply and divide.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>add</td>
<td>subtract</td>
<td>multiply</td>
<td>divide</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 2. Writing an addition equation
If you were to state the process for adding the numbers in column B it would be "six plus three." The equation could be written exactly like that (=6+3) and Excel would display the expected answer, 9. However that equation would be useless if the numbers in either B2 or B3 were changed. When writing your own equation, use cell addresses.

=B2+B3

When writing the equation, clicking in cell B2 displays B2 in the equation. If you have written the equation correctly you may accept it by pressing the Enter/Return key or by clicking on the green check mark. If you change your mind, click on the red X to cancel the operation.

Step 3. Writing other simple functions
Symbols for the four basic mathematical functions are:
- addition +
- subtraction -
- multiplication *
- division /

Step 4. Task
Prepare a worksheet with the data displayed under Step 1. Enter the proper equation under each set of two numbers. Do not look at step 5.

Step 5. Compare
Compare your results to those shown below:

<table>
<thead>
<tr>
<th>B</th>
<th>add</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>D</th>
<th>subtract</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>F</th>
<th>multiply</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>18</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>H</th>
<th>divide</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>2</td>
</tr>
</tbody>
</table>

Step 6. Combining functions
If you can write the equation, Excel can perform the math. To illustrate this we will write an equation which will add several numbers, divide to get an average, and then take a percentage of that number to provide a weighted component of an equation used to average grades.

Scenario: Bill took three tests scoring 88, 76, and 58. The average of his tests counts as half of Bill's grade. What number value has Bill achieved toward his term grade?
Using an Excel worksheet - Calculating Percent and Using Absolute Cell Reference

**Step 1. Review percent**
Before showing how to calculate percent with Excel, let’s review how to calculate percent.

A number divided by a second number and multiplied by 100 expresses what percent the first number is of the second number. If you do not multiply by 100 you have the decimal equivalent of percent.

**Step 2. Writing a percent equation for only two numbers**
Solve the following: 2 is what percent of 8?

Now that you are sure you remember the process for calculating percent, use an Excel worksheet to perform the calculations.

<table>
<thead>
<tr>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>8</td>
</tr>
<tr>
<td>8</td>
<td>25</td>
</tr>
</tbody>
</table>

**Step 3. Writing a percent equation for a column of numbers accompanied by a sum.**
Data from the ice cream survey will be used to illustrate how to calculate percentage.

Task: Determine what percent 6 is of 24 by putting the equation into cell C2 of a worksheet similar to the one above.

**Step 4. Auto Fill and problems associated with it**
You probably remember a discussion of Auto Fill on a previous module. That is a convenient way to place information in several cells at the same time. That might sound like a very good way to fill the equation into cells C3 through C9. For instructive purposes we will do that now to see the problem it causes.

Oops! Something wrong there. The problem was caused by the way the equation was written. The equation B2/B10 says, “take the first cell in this equation and divide it by the cell 8 spaces below.” The reason that none of the other equations work is that there is nothing in the cell 8 spaces below any of the cells from B3 to B10. We must find a way of telling Excel to use cell B10 to divide by for each of the other 8 equations.

**Step 5. Absolute Cell Reference**
You tell Excel to use one specific cell, and never move to another relative location in the calculations by using “absolute cell reference.” To specify the cell, place a dollar sign before the column letter and before the row number. Thus, $B$10 says always use cell B10. Let’s go back to the worksheet and re-write the equation in C2.

Notice the answer has not changed. If we were writing only this one equation, we wasted time using absolute cell reference. The real benefit of this equation will be seen when you fill down into cells C3 through C10.

**Step 6. Fill the equation down into the cells below**
As soon as you fill this equation with an absolute cell reference down into cells C3 through C10, the percentages are instantly calculated. Only one more task remains.
Step 7. Format the cells

Unless you need five decimal places, I suggest formatting cells C2 through C10, the highlighted range above, so that one decimal place is displayed.

Right-click on the highlighted range of cells, select Format Cells...

In the category list select Number, and in the Decimal places: box use the down arrow to choose 1.

Click OK, your column of data has a nice uniform appearance.
Creating a Chart or Graph

Step 1. Launch Excel

If Excel is already open on your workstation open a new Excel workbook. There are three ways to do that.

1. Go to the Standard toolbar and click on the New Workbook button.
2. Go to the File menu and select New.
3. Use a keyboard combination: on a Macintosh use Command + N and on a Windows computer use Ctrl + N

Step 2. Enter the data to be graphed.

For the purpose of this lesson you will use data from a Favorite Fruit Survey. Enter it as you see below:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fruit</td>
<td>Number</td>
</tr>
<tr>
<td>Apple</td>
<td>8</td>
</tr>
<tr>
<td>Orange</td>
<td>4</td>
</tr>
<tr>
<td>Banana</td>
<td>3</td>
</tr>
<tr>
<td>Grapes</td>
<td>5</td>
</tr>
<tr>
<td>Peach</td>
<td>3</td>
</tr>
<tr>
<td>Pear</td>
<td>1</td>
</tr>
</tbody>
</table>

Step 3. Highlight data to be graphed.

Do not include the row with heading titles, only the names of fruit and the numbers. If your worksheet looks like the one above; put your cursor in cell A2, click hold the mouse button down and drag to cell B7. Highlighted data should look like the image below:

Note: Cell A2 is selected, the select color extends around the cell

Step 4. Select the Chart Wizard.

That is done by going to the Insert menu and selecting Chart. You can also click on the Chart Wizard button on the Standard toolbar.

Step 5. From the Chart Wizard box that opens select Chart type. For this activity, I selected pie.

After you have selected the Chart type, click and hold your mouse pointer down on the Press and Hold... button to see what your data looks like in the chart type you selected. If you do not like the look, select another chart type. After you have selected the chart type you will have two options:

- Select Next and let Chart Wizard show you a series of options to make changes to your chart.
- Select Finish and Chart Wizard puts your completed chart on the spreadsheet.

The second step taken by Chart Wizard is to verify the range of data being used for this chart. The Data range displayed below is read “all cells from A2 to B7.”
Notice where the cursor is located in the dialog box above. It is pointing to the small box at the end of the line where the Data range is displayed. If the data range should be changed, click on the box the cursor is pointing to.

The dialog box shrinks allowing you to see your entire spreadsheet. You can edit the data range in this small window. When you are finished, click the same box at the end to restore the window.

Select **Next** to go to the dialog box below. This box allows you to add a title to the chart, make changes on the legend, or make changes on the data labels.

Select **Next** to move to the final dialog box which allows you to see the chart as a new sheet or place it on one of the sheets in your workbook.
If you let the Chart Wizard finish your chart after the first dialog box, or work through each of the four steps, your chart will look something like the one Below.
Experiment 6

Objective
MS Access: Tables, Primary Key, Forms, Form connectivity (IU Database).

Starting Microsoft Access
Two Ways
Double click on the Microsoft Access icon on the desktop.

Click on Start --> Programs --> Microsoft Access

Creating New, and Opening Existing Databases
The picture on right gives you the option to:
- Create a New Database from scratch
- Use the wizard to create a New Database
- Open an existing database

The white box gives you the most recent databases you have used. If you do not see the one you had created, choose the More Files option and hit OK. Otherwise choose the database you had previously used and click OK.
Create a database using the Database Wizard
1. When Microsoft Access first starts up, a dialog box is automatically displayed with options to create a new database or open an existing one. If this dialog box is displayed, click Access Database Wizards, pages, and projects and then click OK.
2. If you have already opened a database or closed the dialog box that displays when Microsoft Access starts up, click New Database on the toolbar.
3. On the Databases tab, double-click the icon for the kind of database you want to create.
4. Specify a name and location for the database.
5. Click Create to start defining your new database.

Create a database without using the Database Wizard
1. When Microsoft Access first starts up, a dialog box is automatically displayed with options to create a new database or open an existing one. If this dialog box is displayed, click Blank Access Database, and then click OK.
   If you have already opened a database or closed the dialog box that displays when Microsoft Access starts up, click New Database on the toolbar, and then double-click the Blank Database icon on the General tab.
2. Specify a name and location for the database and click Create. (Below is the screen that shows up following this step)

Tables
A table is a collection of data about a specific topic, such as students or contacts. Using a separate table for each topic means that you store that data only once, which makes your database more efficient, and reduces data-entry errors.

Tables organize data into columns (called fields) and rows (called records).

Each field in the Student Records table contains the same type of information for every student, such as student’s Social Security Number (See Sec 9). This is an example of a COLUMNS.

Each record in a Student Records table contains all of the information about one student, such as their First Name, Last Name, Birthday, Address, and City, etc… This is an example of a ROW.
Create a Table from scratch in Design view
1. If you haven't already done so, switch to the Database Window. You can press F11 to switch to the Database window from any other window.

2. Double-Click on "Create table in Design view".

3. Define each of the fields in your table.
   a. Under the Field Name column, enter the categories of your table.
   b. Under Data Type column, enter the type you want for your categories.
      i. The attribute of a variable or field that determines what kind of data it can hold. For example, in a Microsoft Access database, the Text and Memo field data types allow the field to store either text or numbers, but the Number data type will allow the field to store numbers only. Number data type fields store numerical data that will be used in mathematical calculations. Use the Currency data type to display or calculate currency values. Other data types are Date/Time, Yes/No, Auto Number, and OLE object (Picture).
   c. Under the Description column, enter the text that describes what your field is. (This field is optional).
d. For our tutorial enter the following items:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soc Sec #</td>
<td>Text</td>
<td>Social Security Number. Uniquely identifies a student</td>
</tr>
<tr>
<td>First Name</td>
<td>Text</td>
<td>Student's First Name</td>
</tr>
<tr>
<td>Last Name</td>
<td>Text</td>
<td>Student's Last Name</td>
</tr>
<tr>
<td>BirthDate</td>
<td>Date/Time</td>
<td>Student's Birthdate</td>
</tr>
<tr>
<td>Address</td>
<td>Text</td>
<td>Students Address</td>
</tr>
<tr>
<td>City</td>
<td>Text</td>
<td>City student resides in</td>
</tr>
<tr>
<td>State</td>
<td>Text</td>
<td>State student resides in</td>
</tr>
<tr>
<td>Zip</td>
<td>Text</td>
<td>Zip Code student resides in</td>
</tr>
<tr>
<td>Phone</td>
<td>Text</td>
<td>Student's home phone number</td>
</tr>
</tbody>
</table>

**Primary Key**

- One or more fields (columns) whose value or values uniquely identify each record in a table. A primary key does not allow Null values and must always have a unique value. A primary key is used to relate a table to foreign keys in other tables.
- NOTE: You do not have to define a primary key, but it's usually a good idea. If you don't define a primary key, Microsoft Access asks you if you would like to create one when you save the table.
  - For our tutorial, make the Soc Sec # field the primary key, meaning that every student has a social security number and no 2 are the same.
  - To do this, simply select the Soc Sec # field and select the primary key button.
  - After you do this, Save the table.

**Entering Data**

Click on the Datasheet View and simply start "chugging" away by entering the data into each field. NOTE: Before starting a new record, the Soc Sec # field must have something in it, because it is the Primary Key. If you did not set a Primary Key then it is OK.
Experiment 7

Objective
C compiler Setup, C compiler environment, setting path, saving, opening, compilation.

Theory
Click on

Start→Run

and type the path

`\filesystem\Softwares\Programming Languages Section`

A new window will open. From there right click on the folder named as TC3 and select copy. Now Paste in it in your C or D partition or your USB drive. *As a good approach C drive is normally not recommended for C compiler as C drive is a windows system partition.*

Assuming that the folder has been copied in the root of D drive, open

D: partition→ TC3 folder → BIN →

Double click and open any one of the two TC.exe icons (as shown on right).

The window that opens is the known as the IDE of Turbo C (as shown below)

This IDE window further contains two more windows and a standard tool bar. The blue window is known as the text editor which is used to write the programs. And the Light bluish green window at the bottom is the message box which will display the error or other messages.

Before using the IDE there are few parameters and checks which need to be reviewed every time the IDE of windows is used. Make sure that the folder of TC3 (also known as compiler) has been copied in the root drive i.e. in the first window of any partition and not in sub folders. e.g.

D:\TC3 is correct but D:\TC3\CP\C language\Class work\TC3 is incorrect.
Opening a new File
Close all windows in the Turbo C IDE (if there are any) by clicking in the small green box on the right top corner of each window. On the standard tool bar click file, select new. A new Blue window appears.

Saving a New File
Press F2 key to save this file. Make sure the path where you save this file is same as of compiler e.g. \TC3\BIN
this path is visible at the bottom of save window. The name of the file will always be followed by .cpp extension (dot cpp).

Opening an existing file
To open any previously saved file, click File, select open, in the path option type \TC3\BIN.*.
Asteric means all. The asteric before the dot means all file names and the asteric after the dot means all file types. *.cpp means all files with dot cpp extension.

Setting Directory Paths (to be checked each time the Turbo IDE is opened)
Once you have opened and saved a new file some directories need to be changed according to the location of your compiler in your computer otherwise the compiler make not work properly.
On the standard toolbar click on options then directories. Set the first letter of the first two paths (i.e. Include Directories and Library Directories) according to the location of the compiler or say the letter of the directory where you copied your compiler. The other two paths (i.e. Output Directories and Source Directories) will remain blank. e.g.

Compilation and Output
After you have written the program press Ctrl+f9 to compile and check the output. Alt+F5 key is used to display the output for last compilation.

Technical Exits
To minimize the screen of Turbo C editor press Alt+Enter.
If some where the program hangs up compiler at output or gets busy without passing control to programmer press Ctrl+Pause\Break.
Experiment 8

Objective
Error detection/correction, clrscr, getch. Making first program in C. Saving / copying files to USB or other storage devices.

Theory
How to work in a Turbo C environment. Basic Startup. Here is simple C language program.

```c
#include<stdio.h>
#include<conio.h>

void main(void)
{
    clrscr();
    printf("My First Program");
    getch();
}
```

The first line of this program is `#include<stdio.h>` . Here `#include` tells the compiler to include something and stdio means Standard Input/Output where as .h means that it is a header file or in short we are including standard input/output header file. In the same way the next line is similar to the first one but it has conio.h in it where conio means the black colour console screen where we see our output and .h tells us that this is a header file. In other words we tell the compiler that we are including two files and the code we will write will be of c language as the compiler also supports C++ code.

`void main(void)`
This is third line. The first word in this is void which means any thing that has no value or is useless. The next word is main which is the brain function and is the only function readable in most programming languages. All the other functions are called within the main function. The third word within brackets is also void. The first void means that the main function won’t return any value while the second void means that the main function is not going to accept any value. This complete line means that we have declared the main function here. For example a simple calculator takes two or more numbers from you and returns the result like addition, subtraction, multiplication etc. It may be confusing at this time to understand the void functionality but in experiment 11 we will discuss it in detail.

`
Following the main function line is a curly bracket which marks the starting of mains body. Always remember that if any bracket is opened in C language it needs to be closed hence the last line of the above program marks the ending of main function.

`clrscr();`
This is the first function called inside the main body. All functions will always have a round bracket closing ‘)’ and a semicolon ‘;’ at their end. In that way we easily recognize the number of functions in a program. According to this rule we can identify 3 functions in this program. However other properties in different functions may differ but this identity will be common in all functions. clrscr is short form of clear screen. It clears the screen of any previous output. If not used wont create any error but output will show all previous compilation result.

`printf("My First Program");`
This line has another function known as printf which is used for printing. Within the double quotes is the main body of this function where any character may be printed.

`getch();`
This is the last function of this program. Its name is short form of get character. Its purpose is to get a character. Its used in last to stop the program until a character is entered. If not used wont show any error but the output will
not stop after compilation. In this case the output is checked manually by pressing Alt+F5 key.

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Program</strong></td>
</tr>
<tr>
<td>#include&lt;stdio.h&gt; #include&lt;conio.h&gt; void main(void) { clrscr(); printf(&quot;My First Program&quot;); getch(); }</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exercise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carefully look at the following programs and write the output.</td>
</tr>
<tr>
<td><strong>Program</strong></td>
</tr>
<tr>
<td>#include&lt;stdio.h&gt; #include&lt;conio.h&gt; void main(void) { printf(&quot;My First Program&quot;); }</td>
</tr>
<tr>
<td>#include&lt;stdio.h&gt; #include&lt;conio.h&gt; void main(void) { getch(); printf(&quot;My First Program&quot;); getch(); }</td>
</tr>
<tr>
<td>#include&lt;stdio.h&gt; #include&lt;conio.h&gt; void main(void) { getch(); clrscr(); printf(&quot;My First Program&quot;); }</td>
</tr>
<tr>
<td>#include&lt;stdio.h&gt; #include&lt;conio.h&gt; void main(void) { getch(); printf(&quot;My First Program&quot;); clrscr(); }</td>
</tr>
<tr>
<td>#include&lt;stdio.h&gt; #include&lt;conio.h&gt; void main(void) { getch(); clrscr(); printf(&quot;My First Program&quot;); getch(); }</td>
</tr>
</tbody>
</table>
### Program

```c
#include<stdio.h>
#include<conio.h>
void main(void)
{
    clrscr();
    getch();
    printf("My First Program");
    getch();
}
```

### Output

Write the output for the program on left

---

### Assignment

Using the program below, make a resume showing your complete details.

```c
#include<stdio.h>
#include<conio.h>
void main(void)
{
    clrscr();
    printf("n****************************RESUME****************************");
    printf("n******************************CV******************************");
    printf("n**************************************************************");
    printf("n==============================================================");
    printf("nName                  :   Abc");
    printf("nFathers Name          :   Xyz");
    printf("nDate of Birth         :   dd-mm-yyyy");
    printf("nAddress               :   Engineering Department, Main Campus, Iqra University,");
    printf("n                          Shaheed-e-Millat Road, Defence View Karachi");
    printf("nCNIC                  :   XXXXX-XXXXXXX-X");
    printf("nGender                :   Male");
    printf("nHSC (College\nBoard) :   Science (Pre Engg), Iqra College, Karachi Board");
    printf("nHSC Year              :   August 2005 ");
    printf("nSSC (School\nBoard)    :   Science, Iqra School, Karachi Board");
    printf("nSSC Year              :   August 2003 ");
    getch();
}
```
Objective
Data types. Understanding and Using format specifiers and escape sequences with printf.

Theory
Format specifiers are used to substitute and print values inside a printf or scanf statement which are further applicable on variables. Below is a chart of format specifier examples using printf.

No. | Type                | Syntax | Value                                                                 | Example                        |
--- |---------------------|--------|-----------------------------------------------------------------------|--------------------------------|
1   | Single Character    | %c     | One character within single quotes                                    | printf("%c",'a');              |
2   | String              | %s     | A sentence of an unfixed length within double quotes                  | printf("%s","Iqra Univ");    |
3   | Decimal Integer     | %d     | Any whole number between -32,768 to 32,767                            | printf("%d",12345);            |
4   | Long Integer        | %ld    | Any number between -2,147,483,648 to 2,147,483,647                    | printf("%ld",1234567);         |
5   | Float               | %f     | Any decimal point number between $10^{-308}$ to $10^{308}$           | printf("%f",1234.567);         |
6   | Double              | %lf    | Any decimal point number between $10^{-308}$ to $10^{308}$           | printf("%lf",12345678);        |

Escape Sequences are used to adjust spacing between lines or characters or the characters themselves.

No. | Syntax | Application                      | Example                        |
--- |--------|----------------------------------|--------------------------------|
1   | \n      | New Line                         | printf("\n");                  |
2   | \t      | Tab eight spaces to right        | printf("\t");                  |
3   | \b      | Back space One space back        | printf("\b");                  |
4   | \r      | Carriage return Start of same line | printf("\r");                   |
5   | \"     | Printing double quotes           | printf("\"");                  |
6   | \      | Printing single quote            | printf("\"');                    |
7   | \      | Printing back space              | printf("\"');                    |
8   | \xdd    | Printing characters by Hexa decimal ASCII value | printf("\x45");               |
9   | \ddd    | Printing characters by decimal ASCII value | printf("\d45");               |

Example

```c
#include<stdio.h>
#include<conio.h>
void main(void)
{
    clrscr();
    printf("\n%c %s %d %f %ld","Iqra University",20,35.5,1234567);
    getch();
}
```

**Program**
A Iqra University 20 35.5 1234567

```c
#include<stdio.h>
#include<conio.h>
void main(void)
{
    clrscr();
    printf("%c %s %d %f %ld","Iqra University",20,35.5,1234567);
    getch();
}
```

**Program**
A Iqra University 2035.5 1234567
Exercise
Write the output for following programs and give reasons.

<table>
<thead>
<tr>
<th>Program</th>
<th>Output</th>
</tr>
</thead>
</table>
| #include<stdio.h>  
#include<conio.h>  
void main(void)  
{  
  clrscr();  
  printf("%d",'a');  
  printf("%s","Iqra University");  
  printf("%c",20);  
  printf("%f",35.5);  
  printf("%ld",1234567);  
  getch();  
} | Write the output for the program on left |

Assignment
Use the program below to make your resume with format specifiers and escape sequences showing your complete details.

<table>
<thead>
<tr>
<th>Program</th>
</tr>
</thead>
</table>
| #include<stdio.h>  
#include<conio.h>  
void main(void)  
{  
  clrscr();  
  printf("******************RESUME************************");  
  printf("**************CV******************************");  
  printf("**************************************************************");  
  printf("================================================================");  
  printf("Name                  :   %s","Abc");  
  printf("Fathers Name          :   %s","Xyz");  
  printf("Date of Birth         :   %d-%d-%d",11,11,1989);  
  printf("Address               :   %s","Engineering Department, Main Campus, Iqra University,");  
  printf("Cell Phone            :   0%d-%ld",300,1234567);  
  printf("CNIC                  :   %d-%ld-%d",12345,1234567,1);  
  printf("Gender                :   %s","Male");  
  printf("HSC (College\Board)   :   %s","Science (Pre Engg), Iqra College, Karachi Board");  
  printf("HSC Year              :   %s %d","August",2005);  
  printf("SSC (School\Board)    :   %s","Science, Iqra School, Karachi Board");  
  printf("SSC Year              :   %s %d","August",2003);  
  getch();  
} |
Experiment 10

Objective
Variables, variable names and related errors. Studying different data types, variables, variable names, variable declaration, variable definition, variable initialization, escape sequences.

Theory
Variables are declared by first writing data types followed be a variable name, e.g.

```
int a=10;
```

Here

*int* is data type,
*a* is variable name
and after the equals to sign (=) is the value in it 10
the value is always followed by a terminator

<table>
<thead>
<tr>
<th>No.</th>
<th>Data Type</th>
<th>Syntax</th>
<th>Supported format Specifier</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Single Character</td>
<td>char</td>
<td>%c</td>
<td>One character within single quotes</td>
<td>char a='a';</td>
</tr>
<tr>
<td>2</td>
<td>Decimal Integer</td>
<td>int</td>
<td>%d</td>
<td>Any whole number between -32,768 to 32,767</td>
<td>int a=10;</td>
</tr>
<tr>
<td>3</td>
<td>Long Integer</td>
<td>long int</td>
<td>%ld</td>
<td>Any number between -2,147,483,648 to 2,147,483,647</td>
<td>long int a=12345;</td>
</tr>
<tr>
<td>4</td>
<td>Float</td>
<td>float</td>
<td>%f</td>
<td>Any decimal point number between 10^-38 to 10^38</td>
<td>float a=1234.567;</td>
</tr>
<tr>
<td>5</td>
<td>Double</td>
<td>double</td>
<td>%lf</td>
<td>Any decimal point number between 10^-308 to 10^308</td>
<td>double a=123456;</td>
</tr>
</tbody>
</table>

Variable Names
Variable names will always start with an alphabet.
Variable names can contain numbers (1,2,45,66) and underscores (_) but no other special characters (!@#$%^&*).
Variable names cannot resemble to any predefined word e.g. include, printf, getch, scanf etc..
A variable name cannot be used for multiple declarations.

Example

```
#include<stdio.h>
#include<conio.h>
void main(void)
{
    clrscr();
    char a='a';
    int b=12;
    float c=12.5;
    double d=1234567;
    printf("%c %d %f %lf",a,b,c,d);
    getch();
}
```

Program | Output
----|---
|      | a 12 12.5 1234567
```c
#include<stdio.h>
#include<conio.h>
void main(void)
{
 clrsr();
 char a='a',a1='b';
 int b=12,b1=13;
 float c=12.5,c1=13.5;
 double d=1234567.0,d1=1234568.0;
 printf("%c %d %f %lf",a,b,c,d);
 printf("%c %d %f %lf",a1,b1,c1,d1);
 getch();
}
```

Exercise
Write the output for following programs.

<table>
<thead>
<tr>
<th>Program</th>
<th>Output</th>
</tr>
</thead>
</table>
| #include<stdio.h>
#include<conio.h>
void main(void)
{
 clrsr();
 char a=97;
 int b='A';
 float c=12.5;
 double d=1234567; 
 printf("%c %d %f %lf",a,b,c,d);
 getch();
} | Write the output for the program on left |

Assignment
Using the program below, make a resume with format variables showing your complete details.

<table>
<thead>
<tr>
<th>Program</th>
<th></th>
</tr>
</thead>
</table>
| #include<stdio.h>
#include<conio.h>
void main(void)
{
 clrsr();
 int dd,mm,yyyy,cell1,cnic3;
 long int cnic1,cnic2,cell2;
 dd=11;
 mm=11;
 yyyy=1989;
 cell1=300;
 cnic1=12345;
 cnic2=1234567;
 cnic3=1;
 printf("****************************RESUME**************************");
 printf("****************************CV******************************");
 printf("************************************************************************");
 printf("Name: %s","Abc");
 printf("Fathers Name: %s","Xyz");
 printf("Date of Birth: %d-%d-%d",dd,mm,yyyy);
 printf("Address: Engineering Department, Main Campus, Iqra University.");
 printf("CNIC: %ld-%ld-%ld",cnic1,cnic2,cnic3);
 printf("Gender: Male");
 printf("HSC (College\Board): Science (Pre Engg), Iqra College, Karachi Board");
 printf("HSC Year: August,2005");
 printf("SSC (School\Board): Science, Iqra School, Karachi Board");
 printf("SSC Year: August,2003");
 getch();
} |
Experiment 11

Objective
Declaration, initialization. Studying Math functions.

Theory
Math.h header file is included for the definitions of math functions listed below. It is written as #include<math.h>.

<table>
<thead>
<tr>
<th>Trigonometric / Maths Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>sin(n)</td>
</tr>
<tr>
<td>cos(n)</td>
</tr>
<tr>
<td>tan(n)</td>
</tr>
<tr>
<td>sinh(n)</td>
</tr>
<tr>
<td>cosh(n)</td>
</tr>
<tr>
<td>tanh(n)</td>
</tr>
<tr>
<td>pow(nmb,pwr)</td>
</tr>
<tr>
<td>sqrt(n)</td>
</tr>
</tbody>
</table>

Example

The program below shows the result for math and trigonometric functions. The functions pass the values to variables which are further used for printing in printf.

```
#include<stdio.h>
#include<conio.h>
#include<math.h>
void main(void)
{
    clrscr();
    float a=45,b=1,sn,cs,tn,snh,csh,tnh;
    sn=sin(a);
    cs=cos(a);
    tn=tan(a);
    snh=sinh(b);
    csh=cosh(b);
    tanh(tanh(b);
    printf("\n\n\n Trignometric Functions");
    printf("\n sin 45 = %.2f",sn);
    printf("\n cos 45 = %.2f",cs);
    printf("\n tan 45 = %.2f",tn);
    printf("\n\n Hyperbolic Functions");
    printf("\n sinh 1 = %.2f",snh);
    printf("\n cosh 1 = %.2f",csh);
    printf("\n tanh 1 = %.2f",tnh);
    getch();
}
```

Program | Output
---|---
# include<stdio.h> | Trigonometric Functions
# include<conio.h> | sin 45 = 0.85
# include<math.h> | cos 45 = 0.53
t main(void) | tan 45 = 1.62
{ | Hyperbolic Functions
    clrscr(); | sinh 1 = 1.18
clo float a=45,b=1,sn,cs,tn,snh,csh,tnh; | cosh 1 = 1.54
c sn=sin(a); | tanh 1 = 0.76
c cs=cos(a); |
t tn=tan(a); |
The program below shows the result for math and trigonometric functions. It also demonstrates that some functions may be called within the body of another function. For example here all the trigonometric functions are called inside printf function.

<table>
<thead>
<tr>
<th>Program</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>#include&lt;stdio.h&gt;</code></td>
<td></td>
</tr>
<tr>
<td><code>#include&lt;conio.h&gt;</code></td>
<td></td>
</tr>
<tr>
<td><code>#include&lt;math.h&gt;</code></td>
<td></td>
</tr>
<tr>
<td>void main(void)</td>
<td></td>
</tr>
<tr>
<td>{</td>
<td></td>
</tr>
<tr>
<td>clrscr();</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;n\n\n Trignometric Functions&quot;);</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\nsin   45  =  %.2f&quot;,sin(45));</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\ncos   45  =  %.2f&quot;,cos(45));</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\ntan   45  =  %.2f&quot;,tan(45));</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;n\n\n Hyperbolic Functions&quot;);</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\nsinh  1   =  %.2f&quot;,sinh(1));</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\ncosh  1   =  %.2f&quot;,cosh(1));</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\ntanh  1   =  %.2f&quot;,tanh(1));</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;n\n\n Math Functions&quot;);</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\npow  2,3  =  %.2f&quot;,pow(2,3));</td>
<td></td>
</tr>
<tr>
<td>printf(&quot;\nsqrt  49    =  %.2f&quot;,sqrt(49));</td>
<td></td>
</tr>
<tr>
<td>getch();</td>
<td></td>
</tr>
<tr>
<td>}</td>
<td></td>
</tr>
</tbody>
</table>

Trignometric Functions
sin 45 = 0.85
cos 45 = 0.53
tan 45 = 1.62

Hyperbolic Functions
sinh 1 = 1.18
cosh 1 = 1.54
tanh 1 = 0.76

Math Functions
pow 2.3 = 8.00
sqrt 49 = 7.00

**Assignment**

Program the following.
- Implement the following equation

\[ 3x^4 \sin(180x) + 4x^3 \cos(90x) + x^2 \sin(\tan(45)) + 7x + 9\cos(90x^2) \]

where \( x \) may be user defined value.
**Experiment 12**

### Objective
Taking Input from the user at console screen using scanf and getche commands.

### Theory
- **Scanf** command can take input of different data types at a time.
- **Gerche** command can take only one character input.

### Example
Write the output after supplying appropriate input on console screen.

<table>
<thead>
<tr>
<th>Program</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>#include&lt;stdio.h&gt; #include&lt;conio.h&gt; void main(void) { clrscr(); char a; int b; float c; double d; printf(&quot;Enter character &quot;); scanf(&quot;%c&quot;,&amp;a); printf(&quot;Enter integer &quot;); scanf(&quot;%d&quot;,&amp;b); printf(&quot;Enter float &quot;); scanf(&quot;%f&quot;,&amp;c); printf(&quot;Enter double &quot;); scanf(&quot;%lf&quot;,&amp;d); printf(&quot;%c %d %f %lf&quot;,a,b,c,d); getch(); }</td>
<td>Write the output for the program on left</td>
</tr>
</tbody>
</table>

Write the output for the program on left
Assignment
Use the program below to make a resume that takes input from the user and shows complete details.

Program
#include<stdio.h>
#include<conio.h>
void main(void)
{
 clrscr();
 int dd,mm,yyy,cell1,cnic3;
 long int cnic1,cnic2,cell2;
 printf("n****************************RESUME*****************************n");
 printf("n******************************CV******************************n");
 printf("n**************************************************************n");
 printf("n==============================================================n");
 printf("nName                  :   %s", "Abc");
 printf("nFathers Name          :   %s", "Xyz");
 printf("nDate of Birth         :   (dd-mm-yyyy)");
 scanf("%d %d %d", &dd,&mm,&yyy);
 printf("%d-%d-%d",dd,mm,yyy);
 printf("nAddress               :   %s", "Engineering Department, Main Campus, Iqra University,");
 printf("n                          %s", "Shaheed-e-Millat Road, Defence View Karachi");
 printf("nCell Phone            :   (3XX-1234567)" );
 scanf("%d %ld &cell1, &cell2);
 printf("nCNIC                  :   (12345-1234567-1)");
 scanf("%d %ld %ld", &cnic1, &cnic2, &cnic3);
 printf("nGender                :   %s", "Male");
 printf("nHSC (College\Board)   :   %s", "Science (Pre Engg), Iqra College, Karachi Board");
 printf("nHSC Year              :   %s %d", "August", 2005);
 printf("nSSC (School\Board)    :   %s", "Science, Iqra School, Karachi Board");
 printf("nSSC Year              :   %s %d", "August", 2003);
 getch();
}
Objective
Implementing simple math equations and formulas. Arithmetic operators, conditional operators, assignment operators, Increment/decrement operators.

Theory

<table>
<thead>
<tr>
<th>Arithmetic operators</th>
<th>Relational operators</th>
<th>Assignment operators</th>
<th>Increment/decrement operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Greater Than</td>
<td>Addition assignment</td>
<td>Increment</td>
</tr>
<tr>
<td>Subtract</td>
<td>Less Than</td>
<td>Subtraction assignment</td>
<td>Decrement</td>
</tr>
<tr>
<td>Multiplication</td>
<td>Greater or Equal</td>
<td>Multiplication assignment</td>
<td>*=''</td>
</tr>
<tr>
<td>Division</td>
<td>Less or Equal</td>
<td>Division assignment</td>
<td>/=''</td>
</tr>
<tr>
<td>Remainder</td>
<td>Equal Equal</td>
<td></td>
<td>Not Equal</td>
</tr>
</tbody>
</table>

Example

Explain the following program after careful study.

```
#include<stdio.h>
#include<conio.h>
main()
{
    clrscr();
    int a=2,b=4,c1,c2,c3,c4,d1,d2,d3,d4;
    c1=c2=c3=c4=5;
    d1=d2=d3=d4=8;
    printf("%d %d %d %d","a+b,a-b,a*b,a/b");
    printf("%d %d %d %d","a-b,a*b,a==b,a!=b");
    printf("%d %d %d %d","c1+=3,c2+=3,c3=3,c4=3");
    printf("%d %d %d %d","d1++,++d2,d3--,--d4");
    getch();
}
```

Exercise

Write output for following programs and give reasons.

<table>
<thead>
<tr>
<th>Program</th>
<th>Output</th>
</tr>
</thead>
</table>
```c
#include<stdio.h>
#include<conio.h>
main()
{
 clrscr();
 int a=5;
 printf("%d %d",a++,a);
 printf("%d %d",a - ,a);
 getch();
}

#include<stdio.h>
#include<conio.h>
main()
{
 clrscr();
 int a=5;
 printf("%d %d",a++,a);
 printf("%d %d",a - ,a);
 getch();
}
```
Assignment

Program the following.

- Prompt user to input distance in Kilometers and display it in meters.
- For the following equation $3x^4 + 4x^3 + x^2 + 7x + 9$, substitute the value of $x$ and generate the result.
- Input any number from user and generate its square e.g. square of 8 is 64
- Input any number from user and generate its cube e.g. cube of 8 is 512
- Input a 4 digit number in any integer type variable and sum all the four digits, e.g. int $a = 3487$, result = 22